CATS TUTORIALS
Starting Kurzweil 3000

Using the mouse, place the mouse pointer on
the Kurzweil 3000 picture icon on the desktop and
double click (quickly click two times).




If the Tip of the Day appears you may read it and then

click on the red “X” in the top right corner of the box to
close it.
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Tip of the Day

To type your own document, click the New
button on the toolbar. (The New button has a
picture of a pad of paper.) Start typing in the
blank document that appears.
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Objective #1: Customizing your Kurzweil 3000 Tool

Bar.

a. In the Kurzweil 3000 window Menu Bar, click on
Tools on the Menu bar
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b. Select Customize and then Toolbars.
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c. Here the Customize Toolbars will appear.
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d. Click on the Study Skills tab.
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e. Check the Visible box.

f. Click on the Apply button when the
appears in the checkbox.
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g. Then click on the Reading tab.
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h. Check the Visible box.

I. Click on the Apply button when the check mark
appears in the checkbox.




J. Click on the Writing tab.
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k. Check the visible box.

|. Click on the Apply button when the check mark
appears in the checkbox.



‘5-; Customize Toolbars

Main Toolbar | Study Skils | Feading | Writing
Toolbar Details
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m. Then click on the OK button to save the changes
and close the window.
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Objective #2: Visually Explore and Become Familiar
with the Kurzweil 3000 User Interface.

Kurzweil 3000 User Interface
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\From: Romeo and Juliet

v

by William Shakespeare

Romeo: He jests at scars that never felt a wound.

Enter Juliet above at a window.

But soft! What light through yonder window breaks?
It is the East, and Juliet is the sun!

Arise, fair sun, and kill the envious moon,

Who is already sick and pale with grief

That thou her maid art far more fair than she.

Be not her maid, since she is envious.

aw rrantal livrner 2n lavséd miale ace A e

a. Main Menu Bar f. Document Area

b. Main Toolbar g. Status Bar

c. Study Skills Toolbar h. Close (x) Box
d. Reading Toolbar

e. Writing Toolbar




Obijective #3: Scanning a document

a. Lift the scanner lid and place the book or page

face down on the scanner glass, similar to a Xerox
copy machine.

b. Close the scanner lid.
c. In the Kurzweil 3000 Main Tool Bar, click on the
Scan icon (the fifth button from the left). If the

scanner is not yet warmed up, it will take a few
seconds to do so.
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d. Wait for the image to appear on the screen.
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Scanning multiple pages

1. Lift the scanner lid and place the book or page face
down on the scanner glass, similar to a Xerox copy
machine.

2. Close the scanner lid.

3. In the Kurzweil 3000 window Menu Bar, click on
the Scan Menu, then choose Scan Repeatedly.
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4. Begin to adjust the next page to be scanned when
Kurzweil 3000 begins the second countdown. (If
the scanner is not yet warmed up, it will take a few
seconds to do so, then there will be a countdown
from 10 to 1 before scanning the page. There will
always be a countdown before each page is
scanned.)

5. Click on the End Scanning button on the counter
when the last page has been scanned.
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Adjusting Countdown time: If the countdown time is
too fast, it can be adjusted.

1. If scanning is in progress, wait for the page to
finish, and then stop the scanning by clicking on
the End Scanning button on the counter.

Scan Repeatedly

seconds until next scan...

2. To adjust the countdown time, click on the
Tools Menu, and then choose Options.
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3. The Options Menu will appear.
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4. Click on the “Scanning” tab.
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5. In the middle area you will see the section that
reads “Repeated Scan Delay”

1. Move the slider bar by clicking it with the
mouse pointer and dragging it to the desired
number (the higher the number the longer the
delay).
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6. Click on the Apply button then click the
OK button.
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7. To begin scanning again click on the Menu Bar

click on Scan and then choose Scan Repeatedly.
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Objective #4: Saving the Scanned Pages
a. Click on the File menu.
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b. Select Save AS.
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c. Next to the File name box, type the name of
the file you are currently saving.

Save As E|E|
Save in: |2 Kurzweil 3000 / o = Bk E
53 Ssample Documents
v
File name: lHistory Textbook Save
Saveastype  |KESI File Format (*KES) -| Cancel
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d. Click on the down arrow next to the Save in
box, located at the top of the dialog box.

Save As

Save in: |2 Kurzweil 3000 N I=j'[ B

& Desktop

5 5am A
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= = KESI
= Kurzweil 3000

4 My Computer

2 3% Floppy (A2)

« Local Disk {C:)

2 CD-RW Drive (D:)
= CATS_KELVIN (E:)
0 Shared Documents (R

File name: -, My Documents =
“J My Network Places
Save as yper— |RESTFTIE Format ([ .RED) i Cancel

e. Select Desktop from the list.
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f. Click on the Create New Folders picture icon.

Save As

Save in: |[’Ei Desktop
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g. Here the New Folder will appear. You can
rename the folder to any name you like.

Save As

3
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3My Documents
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=3 Kurzweil 3000 Output Audio
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File name: ]History Textbook

Open

Save as fype: ‘KESI File Format (*.KES)

j Cancel
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h. Double click on New Folder.

Save As E|EJ
Save in: ‘Q New Folder LI ':::I ﬁ '
File name: ]History Textbook Save
Saveastpe  |KESI File Format (*.KES) -| Cdncel

\\

I. When the Save As screen comes up click Save.
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Objective #5: Choosing a Reader

a. Click on the Tools Menu.
b. Click on Options.
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c. In the newly opened window, click on the Reading

tab.
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_- Options
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d. In this menu the word “Speaker” appears
twice In this tab. Go to the second occurrence of

the word “Speaker” and click on the down arrow
and select the reader you desire.
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e. Click on the Test Speech button to test the
reader’s voice.

‘3-:; Options

General Reading ]Iend] Irfage | Magnifier] Study Skills| Scanning | Lock Features |
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speed
e H | oo |
70 12497
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f. Choose a reader and click on the Apply
button.
g. Click on the OK button to complete.
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Objective #6: Reading the Scanned Pages

a. Click on the Read button, the green triangle, the
seventh button from the left on the Main Toolbar.
(This button will change and become the Pause
button, with two yellow lines, while reading is in
progress).

a
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b. Click on the Pause button to stop reading.
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Objective #7: Adjusting the Rate of Speech

(Before you adjust the rate of speech, reading must be
stopped).

a. Click on the Red vertical (up and down)
arrows next to the WPM box on the Reading
Toolbar. (These arrows increase and decrease
the number in the box which, in turn, adjusts
the rate of speech. The higher the number the
quicker the reader will read).
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b. After adjusting the rate of speech, click on the
Read button on the Main Toolbar to continue
reading.
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Obiective #8: Finding Definitions

a. Select a word by dragging the mouse pointer over
it.

";, Kurzweil 3000 (Administrator) - [Romeo.kes]
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From: Romeo and Juliet
by William Shakespeare

Romeo: He jests at scars that never felt a wound. a

Enter Juliet above at a window.

But soft! What light through/yonder window breaks?
It is the East, and Juliet is the sun!

b. Click on the Definition button on the Main Tool
Bar.
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c. To maximize the screen click on the little “square”
to the left of the red “X” in the top right corner of
the newly opened window.
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Definition of 'yonder' from American Heritage Fourth Edition E]

adverb,
In or at that indicated place: the house over yonder. I
adjective.
Being at an indicated distance. usually within sight: "Tender hills, " he said, pointing.
pronou.
One that is at an indicated place, usually within sight.
[Middle English, from yond, yond ; see yond. ]

Regional Note: The adverb yonder, from Old English geond, is not exclusively Southern but is more frequently used there than in d
any other region of the United States. and not only by older or uneducated speakers. Yonder is not merely a Southern synonym for wounda.
there, which in the South tends to mean "only a few feet from the speaker." Yonder carries with it an inherent sense of distance farther
than "there" and is used if the person or thing indicated can be seen: the shed aver yonder, Or it might be nearby but completely out of

=

Lonter Juliet above ar a window.

But soft! What light through yonder window breaks?
It is the East, and Juliet is the sun!
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d. Click on the Read button on the Main Toolbar to
read the definition(s).

d

:5-:‘. Kurzweil 3000 (Administratar] - [Definition of "yonder’ from Americar: Heritage Fourth Edition]
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von-der.

adverb.

In or at that indicated place: the house over yonder.
adjective,

Being at an indicated distance. usually within sight: "Yonder hills, " he said, pointing.
DrONOuN.

One that is at an indicated place. usually within sight.
[Middle English, from vond. yond : see yond.]

Regional Note: The adverb yonder, from Old English geond, is not exclusively Southern but is more frequently used there than in anv other region of the United States, and not only by older or
uneducated speakers. Yonder is not merely a Southern synonym for tfiere, which in the South tends to mean "only a few feet from the speaker." Yonder carries with it an inherent sense of distance
farther than "there” and is used if the person or thing indicated can be seen: the shed over yonder. Or it might be nearby but completely out of sight. as in the next room.

e. Click on the Pause button on the Main Toolbar to
stop reading the definition(s). Reading will also

stop when the entire definition has been read out
loud.

'-g;‘ Kurzweil 3000 (Administrator) - [Definition of 'yonder' from American Heritage Fourth Edition]

aFl\a Edit Scan Read View Tools Reference Window Online Help
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Back / Pause Forward 5 ; Help
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von-der.
adverb.

In or at that indicated place: the houge over yonder,
adjective.

Being at an indicated distance, ugually within sight:

hills,"" he said, pointing.
pronoun.
One that is at an indicated pjace, usually within sight.

[Middle English, from yond, yofid ; see yond ]

Regional Note: The agverb yonder, from Old English geond, is not exchusively Southern but is more frequently used there than in any other region of the United States, and not only by older or
uneducated speakers. fonder is not merely a Southern synonym for zhere, which in the South tends to mean "only a few feet from the speaker.” Yonder carries with it an inherent sense of distance
farther than "there” is used if the person or thing indicated can be seen: the shed over yonder. Or it might be nearby but completely out of sight. as in the next room.
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f. Click on the bottom “X” in the grey box at the top

right corner of the screen to close the definitions
window.

.'5;. Kurzweil 3000 (Administrator) - [Definition of ‘yonder® from American Heritage Fourth Edition] ‘ZHE‘ El

EFI‘E Edit Scan Read View Tools Reference BUILGLOM Cnline Help
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New Open Save Print Back Read Forward Audible Definiton Synonym Syllables Spell Help
[Comtinuous =] by [Sentence =] ot w|al170 wPM  Zoom wla h Page 1 |w afl 1
von-der.
adverb.

In or at that indicated place: the house over yonder.
adfective.
Being at an indicated distance, usually within sight: "Yonder hills, " he said, pointing.
pronoun.
One that is at an indicated Blaee] usually within sight.
[Middle English, from vond. yond ; see vond.]
Regional Note: The adverb yonder, from Old English geond, is not exclusively Southern but is more frequently used there than in any other region of the United States. and not only by older or

uneducated speakers. Yonder is not merely a Southern synonym for there, which in the South tends to mean "only a few feet from the speaker." Yonder carries with it an inherent sense of distance
farther than "there” and is used if the person or thing indicated can be seen: the shad over yonder. Or it might be nearby but completely out of sight, as in the next room.

Obiective #9: Adding Bookmarks within the Document

a. Click on the place in the document where you
would like to add the bookmark.

b. Click on the Bookmark button on the Study Skills
Tool Bar.
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c. The Bookmark dialog box will appear.

'E:,; Bookmarks

Description
But Add W
™N
List Bookmmarks in
v Alphahbetic arder " Reading order
Help
Ok

d. In the Description box, either leave the word that
appears or type a simple one or two word
description of the bookmark.

e. Click on the Add button.
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f. The bookmark dialog box will disappear and an
image of a “book” will appear showing where the
bookmark was inserted within the document.
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From: Romeo and Juliet
by William Shakespeare

Romeo: He jests at scars that never felt a wound.

Enter Juliet above at a window.

.l
But soft! What light through yonder window breaks?

Tt+ 10 tha Dact and Tnliat in +ha aneal

%, arzweil 000 (pdi... | 2B k2000 scanread m, / S mE Q;/ Eime
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Objective#10: Moving to a Bookmark

a. Click on the Bookmark button on the Study Skills

Tool Bar.
& oL TN = i?
Save Print :-. li Back Read Forward Audlble Deﬁnltlon Synonym Syllables Spell HE||:I
i _belSentence_J at VIAIWD WF‘M Zoom VIAJ221/ F'age 1 JV|A{ 'I ‘ [Eg
O @ P P o JA = 2 [ A
Erase Yellow Green Cvan Magenta Footnote Stck\r' Text Voice Delete  Bookmark

b. From the bookmark list, choose the bookmark you

want to return to and click on it.

'5.;? Bookmarks

Description
|Eiut Add |
List Bookmarks in
¢ Alphabetic order " Reading order
/ GoTo Y|
Delete \
C
Help
Ok

c. Then click the Go To button. The cursor will
automatically move to the bookmark you choose.

32



Objective #11: Deleting a Bookmark

a. Click on the Bookmark button on the Study Skills
Tool Bar.

s A LA

EI: «p»@n.ﬁ'&.@

Mew Dpen Save Prlnt DA E|ack F‘.ead Forward Aud|b|e Deﬁmton Synonym Syllables Spell Help

jContmuous _jbylSentence_i at VIAIH"D P Zoorn VIA§221/ Page: 1 ]V%Aa 'I ‘ Ey
A I:'-'-‘.’--'\'-

O PSP DAx ¢ [) @
’ Yellow Green Cyan Magents Footnate Stld(_\_-' Text Vaice Delete  Bookmark

b. From the bookmark list, choose the bookmark you
wish to delete and click on the Delete button.

"':; Bookmarks

Descriptian
But Add |

List Bookmarks in
* Alphabetic order " Reading ordetr

But GoTo

Delete ‘4\

Help b

c. Click on the OK button.
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Objective #12: Highlighting Important Text

a. Click on one of the “highlighter” buttons on the
Study Skills Tool Bar (you can choose Yellow,
Green, Cyan, or Magenta).

"2, |SL
A

B> «>wd N B % i?

Mew Dpen Save Print DA Back Read Forward .-'-\uchble Definition Smonym Syliables Spell Help

]Continuous belSentence_J at w170 WPM  Zoom: VIA 221% Page: 1 JV|A| 1 ‘ Ey

O @ @ @ o)A £ 1 &
Yellow Green Cyan Magenta Footmote  Sticky Text s Vaice Delete  Bookmark
Slfte =l]Bold Zl|LetAlioned =] |Single Spaced =] §%| @

b. Drag the mouse pointer over an area of text in
order to highlight it.

;{,‘ Kurzwel[i()()()(Admm strator) - [R lomeo. kes] ]

K : EBR)
=] ,«p»(ﬁ)n..ﬁ'a'@

]NEW—D_h.]—_J wamz xj:jlmup TY:AT _j--
NOPPSODA 5 £ 1

[ =] JI = = [si -]

c. Click on the same “highlighter”” button chosen in
order to turn the highlighter off.
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Objective #13: Erasing Highlighting from Text

a. Click on the Erase button on the Study Skills Tool
Bar.

PR RN AN

F‘.ead Forward Aud|b|e Deﬁmton Synonym Syllables
1Contlnuous

__i by]Sentence_i at vjAlﬁ'D WF‘M Zoorn VIA§221/

N O @ P P oA
¥ Erase Yellow Green Cyan Magents Footnate Sticky Text

=] 6o =] [Lett Aigred

Spell Help

Page 1 ]V%Aa“_‘ 1 J [=H | 5

Delele  Bookmark

Voice

b. Drag the mouse pointer over the area of text you no
longer want highlighted.

..g_:‘ Kurzweil 3000 (Administrator) - [Romeo.kes]

ools Reference Window Online

= / “ D » G N W e s @
New  Open  Save Back  Read  For
C-.or_\tir\uuus- =] by [sen

rwar rd dh\ fi

_L_[]‘?E—WPM oar .ﬂzzw = ?hv_" ng W_HT = @
\Q@@@ DA ¢ 0@
[ Green Cyan M ema tnote Shd? t Voice Bookmark
| =[ie HJ =] [ =] [sig-5 =¥ a

From: Romeo and Juliet <"

E]
ut soft! What light through yonder window breaks?

T+ 10 tha Dant and Taliat in 4lha aeaeal

c. Click on the Erase button to turn off the erase
feature.
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Objective #14: Printing a document

a. Click the Print button on the Main Tool Bar.

> o D »4)” %, @

Dpen Save Print F.lack Read Forward Aud|b|e Deﬁmtlon Synanym Syllables Spell Help

jC.Dnt.inuous _jbylSentence_j at TJAIWD WF'M Zoom v]AgEE‘I/ Page 1 ]v{AH 1 ‘ |

O @ @ o DA £ 1 &8
y Yellow  Green Cyan Magenta Footnote  Sticky Text Ty DR B
[al e =] [ea ®llLctAined B [cinde Spaced. e [

b. Choose “Document” and then click Print

=., Print Options

Current Printer; |HP Lazerdet 8150 Series PCL wi

Print Options Ennt
//”r Document ez 8
{ Cancel
~
Setup...
[ Force Black and YWhite
Help
[ Fitto Faper
Frint Range
v Al

" Current page

" Pages  from: |1 to:
Mumber of Copies: ’1_%'

i
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c. To print highlighted text click on the Print button
on the Main Tool Bar.

<, Kurzweil 3000 {Administrator} [Romso.kes]

View Tools Reference  ‘Window Online Help

BE > ur»d VW P
MNew Cpen Say Print Scan Back Read Forward Audble Definiton Synonym Syllables  Spell

| Continuous MSentencej at leIﬂ’D WPM  Zoom: Vl‘i22‘l/o vI Page: Ilel | [

/ Erase Yellow Green Cyan Magenta Footmote  Sticky Text Close Voice [elete  Bookmark

i.-'l-.n'n;l ;I |1E§ ll IBGIC! ;‘ |I_c—.I|. Aligned _'I ISu.—.gIs Spaced ;I J | i~ ]

d. Choose “highlighted text”.

reil 3000 (Admini: stmtar) [Romea.kes]

"‘3«.»@,..‘,-‘%

ave Pmt Sear Back  Read Forward Audble Definiion Synomym Syllables  Spell H?J
entence ¥ | thlwu WPM  Zoom: W|af221% x| Pae 1 |wlall 1 (5]
@ @ o) A [P X
a8 1 Cysn  Magenta Foolnote  Sticky  Text  Co- | CypentPrinter; |HP LasarJet 8150 Series PCL wi
[arial e = feod =] [Left Aligned [Srad
~Print Options
2 _  Document
£ Iotes
Setup.
!_ Force Black and Whita
Help
™ Fitto Paper

~Print Range

1>

Cancel

Al
 Current page

 Pages  from: |1 1o, \

Mumberaf Copies ,_3 |

F Co

Lo l— Top [0 L

Right oo Botiam |00

£ Kurzwel 3000 (Admi... EE»;—mn scanread m...

e. Click on the Print button.
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Objective #16: Reading Web Sites

In Kurzweil 3000, when reading from the web users can
still access Internet Explorer, other Web sites as well as
search the Web.

a. On the Menu Tool Bar click on Read and choose
Read the Web.

'E;J Kurzweil 3000 (Admiristrator)

File Edit Sckn =GN \View Tools Reference Window Online Help
i _ . i d E Forwerd  Audible o ¢ yllat Spell Help

Confinuous Y : !]:W WP Zoom: m Page: | J | H_ I

o | Reading Speed 4 A = : =

y 1\ Silent Reading F : s X 4 i gt

& ellaw Read Mode + Benta E t L Voice slete Books
o\ Resdui y i ®[Cekdigred  ElSinde Soaced IR
| Language r
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b. You will then see the Web browser window.

3 Queensborough Community College - The City University of New York - Microsoft In... |Z]‘E|
File Edit View Favorites Tools Help i

(%)
o

XX

7

= 2 P 2 z == A 5 5 ) = »
1] E‘ o = ﬁ € J=E >} Iﬂ Ig _h ’~ ! Search . Favorites {-‘} =2 &z # - _l
Mew Open & Print T Back Read Forward Audible oy Syllables : =
e St iekfhivd Sl Rt B U SRS e b MR e e T . 3 e
]Continunus LJ by |Senlence j at vjA 170 WPM  Zoom: WP Aﬂﬁl[l"/o - Page: 1 v]AH . |§']ht1p fllvw,acc.cen.cd |
A T — About Us Academics Registration Visitors Quick Links

i |

IT ALL STARTED AT

QUEENSBOROUGH

COMMUNITY COLLEGE kI

[eial I | I || =
YWelcome to the College

Welcome

to the College

Administrative Offices Future Students

it s

Offces ASAP »» Queenshorough
alendarstalendars Faculty & Staff

CampusCampus Get Your Degree ASAP

CETLCenter for Excellence

College Catalog ,

College . } /

Catalog Imaglne' |

Contact Us Queensborough Student Nadia Aboley Wins 15t Place in

Contact the 10th Annual CUNY Conference in Science and

Us Engineering: Minority Science Initiatives in CUNY's

Giving to the College Decade of Science. Read more...

Giving

to the College Important Dates...

GovernanceGovernance O 4/16/2006 Planned Parenthood-A Pk, Lot

D 4/16/2007 Stress Free Tax Day-SUL

0 4/16/2007-4/20/2007 Asian Heritage Mo, Movies-SUL
O 4/17/2007 Academic Senate Meeting

O 4/17/2007 QCC MensBaszhallvsNassau CC

B More Important Dates...

Institutional Review Board
Institutional

Review Board
MissionMission

News & Events

News
& Events [Contact Us] [Emergency Closing Info] [Sits Index]
Plans, Policies & Procedures : 2 222-05 56th Avenue Bayside, NY 11364 718-631-6262
Plans = ArkGallery = Catalog = CETL = Continuing Education = Giving To QCC = Holocaust Cer
, Policies & Procedures = = | — =
PublicationsPublications = =
Eff:tnsf!:lno:'\t‘i:" g é‘l Kurzweil 3000 is ready to read. @ Internet

\ =t I Read Mode Read By WPM
« ’ »] ]ﬁ ‘k J Continuous LJ ]Sentenca Lj t}ﬁﬂ X

/4 start € kurzwel 3000 (Admi... | EH k3000 scan-ead = ..

v P

c. Also you will see the Kurzweil 3000 Read the Web
Toolbar at the bottom of your screen.
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Applying Reference Tools to the Websites
In the Internet Explorer window double click on the
word you want to look up.

d. In the Read the Web toolbar, click on the
Definition icon for the word you selected.

e. You can also click on the Syllables icon for the
word you selected.

ey
to the College

Governance Governance
Institutional Review Board
Institutional

Review Board
MissionMission

News & Events

News

& Events

Plans, Policies & Procedures
Plans

. Policies & Procedures
PublicationsPublications
SportsSponts

Academic Affairs Office
Academic

Affairs Office

Academic Standina

“ D> WP

o Read Mode Read By WPM
‘)§ |C0ntinu0us ﬂ |Sentence j iﬁ'l?ﬂ

000 sca ad ]
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If you click on the Syllables icon this screen will appear.

£_ Word Syllables

Selected Word: [Institutional

Syllables: |in-sti-tu-tion-al

Pronunciation 1 of 2.

Pronunciation: |10 'Sﬁ'—tﬁ]'sha.

Eronounce

[Next Dane | Help |

[ Pronunciation Key

f. To exit the Read the Web mode, click the X on the
lower right-hand corner of the screen.

PublicationsPublications

:10
Monday

® = 1) s, o a 12:
S HEE Ly

Objective #15: Exiting Kurzweil 3000

a. To exit Kurzweil 3000 click on the Red “X” button
in the top right corner of the screen. (Remember to
save your work before you exit Kurzweil 3000).

£, Kurzweil 3000 (Administrator)

File Edit Scan Read View Tools Reference Window Online Help

: 4}” ._I*; = .9' @
¢ v Audible D o sl Hep
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